Notices

No part of this manual may be reproduced in any form or by any means (including electronic storage and retrieval or translation into a foreign language) without prior agreement and written consent from Agilent Technologies, Inc. as governed by United States and international copyright laws.

Manual Part Number
G4650-90008

Edition
October, 2006
Document Revision 3.2
Printed in USA
Agilent Technologies, Inc.
6612 Owens Dr.
Pleasanton, CA 94588-3334

Warranty
The material contained in this document is provided “as is,” and is subject to being changed, without notice, in future editions. Further, to the maximum extent permitted by applicable law, Agilent disclaims all warranties, either express or implied, with regard to this manual and any information contained herein, including but not limited to the implied warranties of merchantability and fitness for a particular purpose. Agilent shall not be liable for errors or for incidental or consequential damages in connection with the furnishing, use, or performance of this document or of any information contained herein. Should Agilent and the user have a separate written agreement with warranty terms covering the material in this document that conflict with these terms, the warranty terms in the separate agreement shall control.

Technology Licenses
The hardware and/or software described in this document are furnished under a license and may be used or copied only in accordance with such license.

Restricted Rights Legend
If software is for use in the performance of a U.S. Government prime contract or subcontract, Software is delivered and licensed as "Commercial computer software" as defined in DFAR 252.227-7014 (June 1995), or as a "commercial item" as defined in FAR 2.101(a) or as "Restricted computer software" as defined in FAR 52.227-19 (June 1987) or any equivalent agency regulation or contract clause. Use, duplication or disclosure of Software is subject to Agilent Technologies’ standard commercial license terms, and non-DOD Departments and Agencies of the U.S. Government will receive no greater than Restricted Rights as defined in FAR 52.227-19(c)(1-2) (June 1987). U.S. Government users will receive no greater than Limited Rights as defined in FAR 52.227-14 (June 1987) or DFAR 252.227-7015 (b)(2) (November 1995), as applicable in any technical data.
## Contents

1. **Using This Guide** ................................................................. 8
   - Introduction ............................................................................ 8
   - Who Should Read This Guide? ................................................. 8
   - Documentation Conventions .................................................... 8

2. **Basics of Operation** ............................................................. 9

3. **Instrument Wizard** .............................................................. 9
   - Offline Instrument Wizard ...................................................... 10

4. **Client/Server Operation** ...................................................... 11

5. **About the Navigation Pane** .................................................. 11

6. **Navigate the Instrument Window** ........................................ 13

7. **Data Acquisition Using Agilent Instrument Controllers** .... 14
   - User access to runs in progress .............................................. 14
   - Closing a Server Instrument .................................................. 15

8. **Program Architecture and Data Structure** .......................... 15
   - About Method Files ............................................................. 15
   - About Data File Structure .................................................... 15
   - Turn on Extended Security .................................................... 17
   - Extended Security ............................................................... 17
   - View the Method Audit Trail .................................................. 17

9. **Opening and Saving Files** .................................................. 19
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open Data Files</td>
<td>19</td>
</tr>
<tr>
<td>Open Data File Options</td>
<td>20</td>
</tr>
<tr>
<td>Open Method and Sequence Files</td>
<td>22</td>
</tr>
<tr>
<td>Save Data Files</td>
<td>23</td>
</tr>
<tr>
<td>10 Reading CDF Files</td>
<td>25</td>
</tr>
<tr>
<td>11 The Instrument Window</td>
<td>25</td>
</tr>
<tr>
<td>Start an Instrument</td>
<td>25</td>
</tr>
<tr>
<td>Instrument Login</td>
<td>25</td>
</tr>
<tr>
<td>View the Instrument Activity Log</td>
<td>27</td>
</tr>
<tr>
<td>About the Instrument Window</td>
<td>28</td>
</tr>
<tr>
<td>Change View Preferences</td>
<td>29</td>
</tr>
<tr>
<td>Preferences - General</td>
<td>30</td>
</tr>
<tr>
<td>Change File View Preferences</td>
<td>30</td>
</tr>
<tr>
<td>Locking your screen</td>
<td>31</td>
</tr>
<tr>
<td>12 The Chromatogram Window</td>
<td>32</td>
</tr>
<tr>
<td>About The Chromatogram Window</td>
<td>32</td>
</tr>
<tr>
<td>View Tiled or Overlay Data</td>
<td>33</td>
</tr>
<tr>
<td>Zooming</td>
<td>34</td>
</tr>
<tr>
<td>Scroll the chromatogram</td>
<td>34</td>
</tr>
<tr>
<td>Add a Trace (Viewing Multiple Chromatograms)</td>
<td>35</td>
</tr>
<tr>
<td>Add Multiple Traces to a Chromatogram Window</td>
<td>38</td>
</tr>
<tr>
<td>Annotate a Chromatogram</td>
<td>40</td>
</tr>
<tr>
<td>Change the Chromatogram Appearance</td>
<td>42</td>
</tr>
<tr>
<td>Change the Axis Properties</td>
<td>47</td>
</tr>
<tr>
<td>Section</td>
<td>Page</td>
</tr>
<tr>
<td>------------------------------------------------------------------------</td>
<td>------</td>
</tr>
<tr>
<td>About Graphical Method Programming</td>
<td>71</td>
</tr>
<tr>
<td>15 Data Acquisition and Control</td>
<td>74</td>
</tr>
<tr>
<td>Data Acquisition and Control</td>
<td>74</td>
</tr>
<tr>
<td>Single Run Acquisition</td>
<td>74</td>
</tr>
<tr>
<td>Run a Sequence</td>
<td>79</td>
</tr>
<tr>
<td>Stop a Run in Progress</td>
<td>82</td>
</tr>
<tr>
<td>Extend a Run</td>
<td>83</td>
</tr>
<tr>
<td>16 Turn Off GPIB Instruments</td>
<td>84</td>
</tr>
<tr>
<td>17 Tutorial</td>
<td>85</td>
</tr>
<tr>
<td>Tutorial Overview</td>
<td>85</td>
</tr>
<tr>
<td>18 Tutorial - Acquiring and Analyzing Data</td>
<td>86</td>
</tr>
<tr>
<td>Instrument and Method Wizards</td>
<td>86</td>
</tr>
<tr>
<td>Create a Data Acquisition Method</td>
<td>88</td>
</tr>
<tr>
<td>Acquisition Setup</td>
<td>88</td>
</tr>
<tr>
<td>Save Your Method</td>
<td>90</td>
</tr>
<tr>
<td>Run a Preliminary Sample</td>
<td>91</td>
</tr>
<tr>
<td>Set Integration Parameters Graphically</td>
<td>92</td>
</tr>
<tr>
<td>Create a Calibration</td>
<td>95</td>
</tr>
<tr>
<td>Calibrate Using a Stored Data File</td>
<td>99</td>
</tr>
<tr>
<td>Create and Run a Sample Sequence</td>
<td>100</td>
</tr>
<tr>
<td>Run a Sequence</td>
<td>105</td>
</tr>
<tr>
<td>19 Using the Tutorial Files</td>
<td>106</td>
</tr>
<tr>
<td>Review Multi-level Calibration Curves</td>
<td>106</td>
</tr>
</tbody>
</table>
Explore a Peak Table ................................................................. 108
Examine a Custom Report ....................................................... 109
Changing Integration Parameters ........................................... 111
1 Using This Guide

Introduction

This User’s Guide provides a basic operating overview and Tutorial for the Agilent EZChrom Elite data system.

Who Should Read This Guide?

This document is designed for new users who will be doing acquisition of data and processing of results.

Documentation Conventions

The following conventions are used in this guide.

<table>
<thead>
<tr>
<th>Convention</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Bold</strong></td>
<td>Database names, table names, column names, menus, commands, dialog box options, and text that must be typed exactly as shown.</td>
</tr>
<tr>
<td><em>Italic</em></td>
<td>Placeholders for information you must provide. For example, if you are instructed to type ServerName, then you must type the actual name of the server instead of the italicized term.</td>
</tr>
<tr>
<td><strong>Monospace</strong></td>
<td>Programming code samples and display text.</td>
</tr>
<tr>
<td><strong>ALL CAPITALS</strong></td>
<td>The keys you press on the keyboard. If combined with a plus sign (+), press and hold the first key while you press the remaining key(s). For example, press SHIFT+TAB.</td>
</tr>
</tbody>
</table>
2 Basics of Operation

This section describes the basic operation of EZChrom Elite, its file structure, features of the application windows and chromatogram windows.

3 Instrument Wizard

Each time you start an instrument application (by double-clicking the instrument icon from the Main window), an Instrument Wizard will appear. This wizard is designed to direct you to the basic functions of the instrument window.

Create or modify a method

This button starts the Method Wizard that will enable you to step through creating or modifying a method.
Create a sequence

This button starts the **Sequence Wizard** that steps you through creation of an acquisition or reprocessing sequence.

Run one sample

This button opens a dialog where you can use a stored method to run a single sample.

Run sequence of samples

This button opens the Run Sequence dialog where you can start data acquisition using a stored sequence.

Show at instrument startup

If this box is selected, the Instrument Wizard will appear each time this instrument is started.

**Offline Instrument Wizard**

If you are using an instrument offline, the Instrument Wizard will display the following buttons, for creating methods, sequences, or processing a stored sequence.
4 Client/Server Operation

When operating in a Client/Server mode, you will have one or more Client Workstations along with one or more Agilent Instrument Controllers, configured on a network. All instruments are physically attached to the Agilent Instrument Controllers (AICs), and the Agilent Instrument Controllers are the machines where the actual data acquisition and control of instruments occur. The client workstations, running the Client/Server software, are where the users of the systems develop methods and sequences, and perform all operations of the system, including submitting data acquisition runs and sequences to the Agilent Instrument Controllers.

5 About the Navigation Pane

By default, a Navigation pane is displayed at the left side of the instrument window. This view enables you to quickly switch between the major functions of the instrument window. A functional area can also be accessed by clicking on one of the function bars located at the bottom of the navigation pane.
To turn the Navigation pane on
1. Select View followed by the Navigation pane command.

To turn the Navigation pane off
1. Click the x button at the top of the Navigation pane.

You can also "park" the Navigation pane at the left of the Instrument window, which provides additional work space. Once the Navigation pane is parked, you can view it again by simply moving your mouse over the Navigation tab that appears at the left. The pane will disappear when you move your mouse back into the work space.

To "park" the Navigation pane
1. Click the push-pin button at the top of the Navigation pane.

6 Navigate the Instrument Window

The navigation pane of the instrument window gives you single-click access to method, sequence, report, control, and viewing options. The navigation buttons at the bottom of the navigation pane open command trees that give you access to commands that are also available from the menu bar of the instrument window.

<table>
<thead>
<tr>
<th>Navigation button</th>
<th>Displays</th>
</tr>
</thead>
<tbody>
<tr>
<td>Method</td>
<td>Method commands, Data manual integration fixes, and Window commands for</td>
</tr>
<tr>
<td>Sequence</td>
<td>Edit, Properties</td>
</tr>
<tr>
<td>Reports</td>
<td>Reports, Report template properties</td>
</tr>
<tr>
<td>Control</td>
<td>Instrument Setup, Run Queue, Instrument Status</td>
</tr>
</tbody>
</table>
When you start a run or a sequence from a client workstation, you are actually submitting that run or sequence to the Agilent Instrument Controller (AIC) or EZServer where the instrument is attached. Once you have submitted a run or sequence, the AIC assumes control over the acquisition and control functions. All methods and sequences are copied to the AIC when a run queue item is submitted to the server. If the network goes down, the Agilent Instrument Controller will continue to run with the files it has on its hard disk.

**User access to runs in progress**

As the user who submitted the run or sequence, you will have access to the **Stop Run, Extend Run, or Stop Sequence** functions. If you are not the user who submitted the run or sequence, you can view the run (if you have instrument rights), but you cannot stop a run or sequence that has been started by another user. Users with **System Administration** or **Instrument Administration** rights have full access to the run and sequence functions.

Once you have submitted a run or sequence to an AIC from a client workstation, you can modify the method. You must save the file (**File>Method>Save**) in order for the changes to be used for subsequent sequence runs that use this method. If more than one client changes and saves the method, the last client’s changes are saved and all others are lost. If the method is not saved before the start of the next sequence run using this method, the changes on a client will be lost when the next sequence run starts.

The user who submitted a sequence to the AIC may add or remove runs from the submitted sequence from a client workstation (if the user has appropriate privilege assignment). In order for sequence changes to take effect, the sequence must be saved (**File>Sequence>Save**). When the sequence is saved, all other clients will be notified of the
change, and the next run of the sequence will be executed from the modified sequence.

**Closing a Server Instrument**

Once an instrument application is started on an Agilent Instrument Controller, it will remain open after all runs are completed. Occasionally, it may be necessary to close a server instrument (for example, to re-configure). Users with Instrument Administration privileges can close a server instrument by doing a right-hand mouse click on the instrument icon in the CS Main window, then selecting the **Close Server...** command. You will be prompted to confirm your choice.

If you select Yes, the command will force the server instrument to close after it finishes the runs and all clients have been disconnected.

---

**8 Program Architecture and Data Structure**

**About Method Files**

A method is used whenever you acquire and/or reprocess a data file. It contains instructions for data acquisition (run time, sampling rate, etc.), integration, calibration and peak information, and reports, as well as optional functions such as data export and user programs. Each method is capable of acquiring multiple independent channels of data from a single chromatograph. Each channel can have its own complete independent parameters, including sampling rate, run time, integration events, external events, calibration, and reporting.

Although the method file is a separate file, the information contained in the method is saved in the raw data file at time of acquisition. This way, the original method can be reproduced, even if the method file was subsequently modified.

**About Data File Structure**

A data file is created on the designated drive whenever you acquire a sample, or when you save a data file using the **Save**
As 32-bit... command. The file contains the following information:

**File Information Header.** This contains information such as the date and time of acquisition.

**Complete method parameters used to acquire and process the data (this is the "original" method saved only when the data is acquired).** Because you can acquire multiple channels of data simultaneously on a given chromatograph, the method section may contain complete parameters for more than one channel.

**Raw data points for the run saved.** Multiple chromatograms may be present in a single data file, each of which represents a detector channel acquired for the run. The raw data points are saved in binary format.

**Results.** The original integration results are saved in the file and can be recalled later when the file is opened. In addition, the most recent analysis results and method are also saved in the data file and updated whenever you analyze. The Sample ID for the results is also saved, as are manual integration fixes.

**File Description.** If you entered a description for the file, this text information is stored with the file, and can be viewed under the Data File Properties or from the Open Data File dialog.

**Instrument Configuration.** The configuration of the instrument used to acquire the data file is saved.

**Data File Audit Trail.** An audit trail log is always saved in the data file that tracks analysis of the data.

Data files are saved using the file name and extension you specify when you initiate the data acquisition. The limit on file name length is 255 characters, including path.

**Data File Checksum.** If Extended Security is enabled, a checksum is calculated for the entire file whenever the data file is closed. When the file is opened, its checksum is verified first. If the check fails, the file cannot be opened and an error message will appear in the instrument activity log. Checksum verification, when enabled, is enterprise-wide. The checksum feature is enabled from the **Enterprise Options** dialog in the...
Main menu, and is labeled **Extended Security**. GLP and Extended Security

**Turn on Extended Security**

In order to adhere to good laboratory practices, the software does not let you over-write a data file. If you try to over-write an existing data file name, the system will either give you an error message, or trigger a failure action if encountered during a Sequence operation.

If, for some reason, you wish to ignore GLP and have access to over-writing of data files, your files must be located in a directory whose path contains the term "public". For example, if your data files are saved in a folder entitled "\Public\Data", the software files saved in this folder can be overwritten.

**Extended Security**

To turn ON Extended Security,

1. From the Main Menu, click **Tools** followed by **Options...** and then select the **General** tab.
2. Click **Extended Security** if the box is not selected already.

This selection is ON by default. When this option is selected, causes a checksum to be calculated whenever a data file is closed. When the file is subsequently opened, its checksum is verified first. If the check fails (the calculated checksum for the file does not match the one previously calculated for the file) the file cannot be opened, and an error is posted in the instrument activity log. Checksum verification is enterprise-wide.

**View the Method Audit Trail**

Each Method file can have an Audit Trail enabled. When this is enabled, changes to the method will be logged in the file and cannot be removed or overwritten. To view the changes logged in the Audit Trail for a method,

1. From the **File** menu, select **Method** followed by **Audit Trail...** This will display the Audit Trail listing for the
current method. If the audit trail option is turned on for the current method, this box will display the logged changes to the method.

<table>
<thead>
<tr>
<th>User</th>
<th>Logged</th>
<th>Source</th>
<th>Activity</th>
<th>Reason</th>
</tr>
</thead>
<tbody>
<tr>
<td>System</td>
<td>4/3/97 10:17:26 AM</td>
<td>Integration Events...</td>
<td>Added (Enabled: Yes, Type: Width, ...) Width c...</td>
<td></td>
</tr>
<tr>
<td>System</td>
<td>4/3/97 10:17:26 AM</td>
<td>Named Peaks - P...</td>
<td>Calibration Weight changed from 0 to... Averag...</td>
<td></td>
</tr>
<tr>
<td>System</td>
<td>4/3/97 10:17:26 AM</td>
<td>Named Peaks - P...</td>
<td>Calibration Flag changed from Repla... Averag...</td>
<td></td>
</tr>
<tr>
<td>System</td>
<td>4/3/97 10:17:26 AM</td>
<td>Named Peaks - P...</td>
<td>Calibration Weight changed from 0 to... Averag...</td>
<td></td>
</tr>
<tr>
<td>System</td>
<td>4/3/97 10:17:26 AM</td>
<td>Named Peaks - P...</td>
<td>Calibration Flag changed from Repla... Averag...</td>
<td></td>
</tr>
<tr>
<td>System</td>
<td>4/3/97 10:17:26 AM</td>
<td>Named Peaks - P...</td>
<td>Calibration Weight changed from 0 to... Averag...</td>
<td></td>
</tr>
<tr>
<td>System</td>
<td>4/3/97 10:17:26 AM</td>
<td>Named Peaks - P...</td>
<td>Calibration Flag changed from Repla... Averag...</td>
<td></td>
</tr>
<tr>
<td>System</td>
<td>4/3/97 10:17:26 AM</td>
<td>Named Peaks - P...</td>
<td>Calibration Weight changed from 0 to... Averag...</td>
<td></td>
</tr>
<tr>
<td>System</td>
<td>4/3/97 10:17:26 AM</td>
<td>Named Peaks - P...</td>
<td>Calibration Flag changed from Repla... Averag...</td>
<td></td>
</tr>
</tbody>
</table>

User The user who was logged into the system at time of the change.

Logged The time the change was logged into the system.

Source The method location of the change – i.e. peak table.

Activity The change that was made.

Reason The reason for the change, if changes were logged.

2. To view the details of a given entry, click on the entry to highlight it, then click the right-hand mouse button. Select the Show Detail command. Details of the highlighted entry will appear.
9 Opening and Saving Files

Open Data Files

Whenever you open a file using the data system, you will be presented with a dialog box that allows you to not only open the file, but specify parameters for searching, as well as previewing file contents. The Open File button on the command ribbon gives you access to the Open File menu.

When you select one of the types of files to open, a dialog will appear where you can select the file from those on your hard disk.

The Open Data File dialog contains the most options for how you want to open and search for files. The list of files of the type selected (Files of type) are shown. As with most Windows applications, you can view these as a list, and show details by clicking the appropriate button at the upper right corner of the window. In addition, you can see a preview of the chromatogram in the data file by pressing the Preview Chromatogram button, or view the file description by clicking the Description button. You can also use the * "wildcard" character to view a list of certain file types. The dialog appearance and behavior will be slightly different for
systems with advanced file security enabled. Users will be limited to storing files within the current project folder and the Enterprise Common folder. A folder bar will be included in the dialog to facilitate navigation.

Open Data File Options

The Options box allows you to save time by loading additional information at the time the data file is opened.

Method

If you select **Current**, the current method will not change when you open the data file. When one of the other Method options is selected, the method selected will be loaded at the time the data file is opened.

**From Results** Loads the method used to create the selected results. **Original/Acquisition** loads the method used for the original acquisition of the data file. This method will replace your current active method.
Results

When one of the Results options is selected, the data file will be opened along with the selected results. When a data file is opened with results, the integration and baselines that generated those results will be displayed automatically when the chromatogram is drawn on the screen. If Most Recent is selected, the data file will be opened with the results from the last time the chromatogram was analyzed. If the Save all analysis results option is turned on (Enterprise Options/General tab), a list of all analysis results will be available for you to open with the file.

Open with Pretreatment

When this box is selected, the pretreatment file (if applicable) used at the time the data was acquired will be opened when the data file is opened.

Searching for Data Files

If you are interested in specific data files, there are options that allow display of only the files of interest. Using the area titled "Find files that match these criteria", you can search for files that contain specific information. You can specify all or part of a Sample ID. You can search for files acquired by a designated Analyst. You can find files that were acquired during a specific time frame such as Yesterday, Last 7 Days, Today. You can also search for files that were modified during a specific time frame. These criteria can be used one at a time or combined.

You can also include wildcards as part of the file name to search. To do the search, fill in the field of interest for files you want to search, then click Find Now. For example, if you enter Tester* in the Sample ID field and click Find Now, all the files where the Sample ID is "Tester" followed by anything will be displayed. Click the New Search button if you want to clear the search settings and use new criteria for searching.
Note: When using the Search feature, make sure the Windows Hide File Extensions for Known File Types option is turned OFF. To turn this off, from My Computer, click Tools followed by Folder Options... and then click the View tab.

Open Method and Sequence Files

To open a method or sequence file,

1. From the File menu, select Method or Sequence followed by Open.

2. The Open dialog boxes for Method and Sequence files are identical. The dialog appearance and behavior will be slightly different for systems with advanced file security enabled. Users will be limited to storing files within the current project folder and the Enterprise Common folder. A folder bar will be included in the dialog to facilitate navigation.
Searching for Method and Sequence Files

The criteria you can use to search for specific method and sequence files include selection of specific text found in the file description (Text in Desc.), Analyst name, and date Created or last Modified.

Note: When using the Search feature, make sure the Windows Hide File Extensions for Known File Types option is turned OFF. To turn this off, from My Computer, click Tools followed by Folder Options... and then click the View tab.

Save Data Files

To save a data file,

1. From the File menu, select Data followed by Save as 32-bit...
2. A dialog opens where you can browse to a location and type the filename to be used to save the file.

This command will save the current data file along with the current method in a single file. This command is only enabled when the current data file is not in 32-bit Elite data format (such as 16-bit or converted files). In order to comply with good laboratory practices, you will not be allowed to Save As 32-bit... using the same name as an existing data file, unless the file is located in a "Public" directory. A Public folder is a folder where the path contains the term "public". Data files in all other data system folders are protected from being over-written. The dialog appearance and behavior will be slightly different for systems with advanced file security enabled. Users will be limited to storing files within the current project folder and the Enterprise Common folder. A folder bar will be included in the dialog to facilitate navigation.
To save the current data in a new data file, type the name of the new data file in the **File name** field, then click **Save**. Use the buttons at the upper right of the dialog box to view **details** of a highlighted file, or to view the **description** of a highlighted file. An entry "Saved from <FILENAME>" will be logged into the saved file as the first entry.

If the **Compress Data** box is selected, the file will be saved in a compressed format. Once saved in compressed format, it will automatically be "decompressed" whenever the file is opened. However, once a file is saved in compressed format, you must do a "save as" command to save it in decompressed format again.
10 Reading CDF Files

When opening a CDF file, the software looks for one of the following Y-axis labels:

"microvolts", "uvolts", "uv", "uau} or "millivolts", "mvolts", "mv", "mau"

If one of these labels is not found, the software will try to read it from an AIA.ini file, which is used to get multipliers for non-standard file types. If there is no AIA.ini file available, the software will try to make an estimate based on the range of values.

If the CDF file being read is non-standard, you need to make an AIA.ini file and put it in the data system program folder. The file should contain the y-axis label and multiplier.

11 The Instrument Window

Start an Instrument

To access the Instrument Window where you can develop methods and sequences, create custom reports, and acquire data, double-click on the instrument icon you wish to start in the main menu. You may be required to log-in before you can access the instrument window functions. See Instrument Login for details.

Instrument Login

Whenever the instrument login and project management is enabled, you will be required to log-in whenever you attempt to start an instrument application.
Enter the information as prompted, and then click the **Login** button.

**User name:**
Enter the user name which has been assigned to you on the network.

**Password:**
Enter your assigned network password.

**Save Password:**
If the "save password" option is enabled by your system administrator, a **Save password** checkbox will appear.
If you select this box, the password you type at login will be saved when you click the Login button. Once the password has been saved, whenever you login to the instrument, the saved password will be used.

Note: The password will be saved when the Login button is clicked, whether or not the login is successful.

Domain:
Select the domain you have privileges on from the drop-down list, or type in the correct domain. (Not shown unless you are using a domain controller.)

Project:
Select a project to log into. This project will become the default project path for methods, data, and sequences in the instrument. You can, however, create and save files in other locations even though you have logged into a designated project.

Once you have logged into an instrument and selected a project, that project’s paths for methods, data, sequences, and templates will be used unless you designate a new project. To change the selected project, use the File/Select Project... command.

View the Instrument Activity Log
As you use a method to acquire data, a log of activity from the current instrument is kept. To view this log, from the File menu, click Instrument Activity Log and then click Display Log. A window with the Instrument Activity Log appears. The window displays the User who used the instrument, the time the activity was logged into the Instrument Activity Log, and a description of the activity.
To view details of any line in the instrument activity log, click on the line to highlight it, then do a right mouse click within the spreadsheet. From this pop-up menu you can view details of the highlighted line, print it, or print the entire activity log. In addition, you can export, archive, or purge the activity log from this menu.

Note: Over time, the instrument activity log file may become large, so periodically you should archive the file to a floppy or another location and then purge it.

About the Instrument Window

When you open an instrument, the Instrument Window will appear. From this window, all aspects of using the instrument are performed, including

- Method Development
- Calibration
- Sequence development
• Instrument control and data acquisition
• Analysis and review of data
• Reporting
• Data export

You can customize the appearance of the application window if you choose, adding or removing the Toolbars and Status information. However, these features are designed to make the system easier to use, and most users will prefer to have these turned ON.

Change View Preferences

To change the appearance of the instrument window,

1. From the View menu, click Preferences.
2. Click General to change the general view preferences for the instrument window.
Preferences - General

This tab is used to set up general preferences in the instrument window.

**Toolbar options**

For each area of the window listed, you can turn on or off the Toolbar and Tooltips if available. Click on the toolbar area, then check the **Show toolbar** and **Tooltips** boxes to enable your choices for that area.

![Preferences dialog box](image)

**Status bar options**

Select the checkbox to turn on the status bar. The status bar provides brief information at the bottom of the instrument window, if enabled.

**Time units**

Select the time units for display of chromatographic information.

**Change File View Preferences**

To change the appearance of the instrument window,

1. From the **View** menu, click **Preferences**.
2. Click **Files** to change the file view preferences for the instrument window.

3. Select the file type, then enter the number of files you wish to display in the **Max files** box. This determines the number of recent files displayed in the **File** menu.

4. Click **Clear Files** to clear the current recent files list for the selected file type.

5. Click **Clear All Files** to clear the recent files for all the file types.

### Locking your screen

To lock the window from unauthorized use, from the **Window** menu choose **Lock**. When you choose this command, all menu items will be "Locked" except for the **Window** and **Help** menu. Locked commands will not be accessible until you unlock them again. This command is useful for multiple user labs, where you may want to lock your current work while you are temporarily away from the computer.

To unlock the screen, click the **Lock** Command again. You will be required to log in your user name and password (if instrument login and project management is enabled) to unlock the screen.
12 The Chromatogram Window

About The Chromatogram Window

Whenever there is data to be viewed, it is shown in a chromatogram window. Normally, one chromatogram will appear in each window, and multiple channel data files will display multiple chromatogram windows - one for each channel. However, it is possible to add multiple traces to a single chromatogram window and perform comparison and mathematical operations on them. To access specialized commands for the chromatogram window, click the right-hand mouse button somewhere within the chromatogram window area. These commands allow you to add graphs or chromatograms to the window, change the appearance, annotations, and axes, perform mathematical operations on chromatograms, and view or change the properties of existing traces in the window.
As data is being acquired, it is also displayed in a chromatogram window. At the end of a run the data becomes the "current data". You can change the appearance of the chromatogram and select annotations, fonts, and labeling. Utilities are available to print the current window view, copy it to a clipboard, or save it in a file.

**View Tiled or Overlay Data**

When viewing data from multiple channel methods, you can choose to view each channel in a separate window (View>Tile Data), or you can overlay all channels in a single window (View/Overlay Data). When all channels are overlaid in a single window, you can still zoom, and change the individual channel appearances, as described below.

When in **Tiled** mode, you can arrange how the windows are tiled on your screen by using the Window>Cascade, Window>Tile Horizontally, or Window>Tile Vertically command.
**Zooming**

You may want to examine a chromatogram in more detail, or zoom in on a portion of the chromatogram. To do this, drag a box around the area of interest by holding down the left mouse button and dragging the box until it highlights the section of interest. Then release the mouse button. To move quickly to the previous level of zoom, double-click on the chromatogram. To zoom to the full chromatogram again after multiple zooming operations, click the right-hand mouse button anywhere in the chromatogram window, then select **Full Unzoom** from the menu displayed. You can also execute a full unzoom of your chromatogram with **Ctrl-Z** or **shift-double click** in the chromatogram window. Once the chromatogram is in a "zoomed" view, you can scroll it. See **Scrolling the chromatogram**.

At the top of the chromatogram window is a display of **Time** and **Amplitude**. These values change as you move the cursor and reflect the time and amplitude of the trace where the cursor is located. If you have more than one trace, you can change the display to another trace by clicking on the chromatogram trace with the mouse. If the traces are displayed in different colors, the color of the Time and Amplitude display will reflect the color of the trace displayed.

**Scroll the chromatogram**

Once you have zoomed in on a chromatogram, you can scroll the chromatogram to the right or left without losing the zoom. This is done by pressing the CTRL SHIFT keys down and moving the mouse until the cursor changes to a "hand" and dragging it to the left or right.

You can also scroll the X- or Y- axis to view features which may be out of the range. To do this, press the CRTL SHIFT keys down while the mouse cursor is outside the graph area, yet near the axis of interest. The cursor will change to an up/down arrow near the Y-axis, or a left/right arrow near the X-axis. Moving the mouse in this mode will scroll the graph up/down or left/right on the axis.

To restore the original view, in the chromatogram window, click the right mouse button and then click **Full Unzoom**.
Add a Trace (Viewing Multiple Chromatograms)

The chromatogram window is used to view data, either current data (real-time) in the instrument window, or data recalled from the disk. You can view multiple chromatograms in a single chromatogram window if you wish. This is convenient if, for example, you want to compare a past run with your current data or overlay an oven or pump profile.

To add a new trace to the chromatogram window,

1. Click the right mouse anywhere in the chromatogram window. A menu will appear.

2. Select the Add Trace... command. When you select this command, a dialog box will appear.
3. Select the **New Trace** tab. Fill in the fields to add a trace to the chromatogram window and set its properties. These properties apply only to the trace selected and are not saved as part of the method. When a new trace is opened, the properties will be set to default values. Added traces are normalized by default.

**Data Source**

Enter the name of the file from which to get the trace. You can also click the File button adjacent to the field and select a data source.
**Current Data**
This selection allows you to select a trace from the current chromatography data.

**Current Method**
This selection enables you to select a trace from your current method (if available). For example, you could load an oven temperature program from an HP5890 instrument method.

**Open Data**
This allows you to select a stored data file from which you can select a trace for display.

**Trace**
Select the trace to be displayed. Click the button to display available traces.

**Scale to**
Select one of the scaling options.

- **Trace x**
  Scales to another trace in the window.

- **Autoscale to largest peak**
  Scales such that the largest peak is on scale.

- **Autoscale to 2nd largest peak**
  Scales such that the 2nd largest peak is on scale.

- **Autoscale to 3rd largest peak**
  Scales such that the 3rd largest peak is on scale.

- **User Defined**
  Allows you to enter a value for Y max and min.

- **Normalized**
  Allows you to normalize one trace to fit on the graph.
**Y min**
If you have selected a User Defined scale, enter a minimum value for the Y-axis.

**Y max**
If you have selected a User Defined scale, enter a maximum value for the Y-axis.

**Units**
Select the units for display.

**X Offset**
Enter a value in units for offset of the X-axis.

**Y Offset**
Enter a value in units for offset of the Y-axis.

**Y Scale**
If desired, enter a multiplier that will be applied to the entire trace here.

---

**Add Multiple Traces to a Chromatogram Window**

If you want to quickly add more than one chromatogram to your view,

1. In the chromatogram window click the right hand mouse button, followed by **Add Multiple Traces**... The Open File dialog box will appear where you can select the traces to be displayed by selecting them from the file list.

2. To add a file, either click on the file name, then click the Add button, or simply double-click on the filename from the list.
3. Once you have added a data file to the list, you can select the channel by clicking on the **Trace** field, then click the down-arrow button. If multiple channels for that file are available, select the desired channel by clicking on it with the mouse.

4. To delete a trace from the display list, click on its name or on its number, then click the **Delete** button.

5. When you are ready to open the multiple traces, click **Open**. The selected files/channels will appear in your chromatogram window.
Annotate a Chromatogram

To change the annotations on the chromatogram,

1. From the chromatogram window, do a right mouse click and then select **Annotations**.

2. Click the **Annotation** tab in the Properties box. This brings forward a dialog where you can designate how you want the trace you are adding to be annotated.
3. Select the trace from the drop-down list. Then select what features you wish to annotate. Normal choice is **Peaks**. However, if you have the SEC option installed, you can select **SEC** to annotate specific SEC features on your chromatogram.

4. For the selected trace, click **Peaks** or **Groups** to select what kind of annotation to use.

5. Click on an **Available Annotation**. When an annotation is highlighted, you can add it to the annotations to be shown by clicking the **Green** arrow key (pointing to the right). This can also be done by double-clicking the selection.

6. For certain annotations, you can also designate the number of places to be displayed to the right of the decimal point. Enter this value in the **Decimals** box for the highlighted item.
7. Click the check box(s) to display **Baseline, USP Width**, or **Retention Time Windows, Show undetected named peaks, and Group ranges** on the trace. With the SEC option installed, you will have access to additional SEC annotation features.

**Note:** The Reference Peak window annotation displays the window set in the Peak Table. This window is not adjusted for relative retention time.

8. Continue to select as many annotations as you wish for this trace. When you have finished, click **OK**.

9. You can select or change annotation for an existing trace by doing a right-mouse click in the chromatogram window, then select the **Annotation** command. The selections you make will apply to all traces you open for this channel or until you change them (the **OK** or **Apply** button). If you want to apply the annotation changes to all open channels, click the **Apply to All** button. Annotations are not saved as part of the method and are considered a function of the instrument application. If you close a method and re-open it, the current settings will apply.

**Change the Chromatogram Appearance**

You can change the appearance of the trace (line type, color, etc.) from the **Appearance** tab in the Properties box. Click on this tab to display the Appearance tab dialog.

To change the appearance of a chromatogram or trace,

1. In the Chromatogram Window, do a right mouse click and select **Properties**.
2. Click the **Appearance** tab.
Scheme

If you have previously saved an appearance scheme on disk, you can select it from this box. The **Save As** button allows you to save the existing appearance scheme on disk by giving it a name. The **Delete** button allows you to delete a scheme and start again.

Item

This drop-down list lets you select which part of the chromatogram window for which you wish to change the appearance. The choices will include the graph itself (including background and legends), and the available traces.

Sub-item

Select the sub-item you wish to modify. The choices for this will change based on the item you have selected. For example, if the Item selected is the
Graph, you will have access to setting up appearances of sub-items including the background, axes and labels for the graph. If the item selected is a chromatogram data channel, you will have access to setting appearances of sub-items such as baselines, start and stop tic marks, and annotation. If the item selected is text, you will have access to the **Font** formatting commands as well.

When a sub-item is selected, you will have access to fields appropriate to that item. For example, if you have chosen the **baseline** sub-item, you can choose the color and line type. If you have chosen the **annotation** sub-item, you can choose the font appearance and color.

You can change the appearance of any trace without adding a new trace, by doing a right-mouse click in the chromatogram window, then selecting the **Appearance...** command. When you select this command, you will see an identical dialog to that shown above for the Appearance Tab.
Sub-items available in the Appearance tab are as follows.

<table>
<thead>
<tr>
<th>Item</th>
<th>Sub-Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Graph</td>
<td>Background</td>
<td>Select the color of the graph background. Default is black.</td>
</tr>
<tr>
<td>Graph</td>
<td>Title</td>
<td>Select a color and font for the Title of the graph. There must be a Graph Title defined in the Axis Setup tab in order for it to appear in the window.</td>
</tr>
<tr>
<td>Graph</td>
<td>Left Y-Axis</td>
<td>Select a color for the left Y-Axis of the graph.</td>
</tr>
<tr>
<td>Graph</td>
<td>Left Y-Axis Major Ticks</td>
<td>Select a color for display of major unit marks on the Left Y-Axis.</td>
</tr>
<tr>
<td>Graph</td>
<td>Left Y-Axis Minor Ticks</td>
<td>Select a color for display of minor unit marks on the Left Y-Axis.</td>
</tr>
<tr>
<td>Graph</td>
<td>Left Y-Axis On/Off</td>
<td>Turns On or Off the Left Y-Axis</td>
</tr>
<tr>
<td>Graph</td>
<td>Right Y-Axis</td>
<td>Select a color for display of a right hand Y-Axis.</td>
</tr>
<tr>
<td>Graph</td>
<td>Right Y-Axis Major Ticks</td>
<td>Select a color for display of right Y-Axis major ticks.</td>
</tr>
<tr>
<td>Graph</td>
<td>Right Y-Axis Minor Ticks</td>
<td>Select a color for display of right Y-Axis minor ticks.</td>
</tr>
<tr>
<td>Graph</td>
<td>Right Y-Axis On/Off</td>
<td>Turns On or Off the right Y-Axis.</td>
</tr>
<tr>
<td>Graph</td>
<td>X-Axis</td>
<td>Select a color for the X-Axis display.</td>
</tr>
<tr>
<td>Graph</td>
<td>X-Axis Major Ticks</td>
<td>Select a color for display of major unit marks on the X-Axis.</td>
</tr>
<tr>
<td>Graph</td>
<td>X-Axis Minor Ticks</td>
<td>Select a color for display of minor unit marks on the X-Axis.</td>
</tr>
<tr>
<td>Graph</td>
<td>X-Axis On/Off</td>
<td>Turns On or Off the X-Axis.</td>
</tr>
<tr>
<td>Graph</td>
<td>Legend</td>
<td>Select a color and/or font for display of the graph legend. The legend indicates what traces are currently displayed in the window. The Legend is turned On or Off from the Axis Setup tab.</td>
</tr>
<tr>
<td>---</td>
<td>---</td>
<td>---</td>
</tr>
<tr>
<td>Graph</td>
<td>Grid</td>
<td>Select a color for display of the grid lines. Grid lines are turned On and Off from the Axis Setup tab.</td>
</tr>
<tr>
<td>Data</td>
<td>Trace</td>
<td>Select a color and/or line type for display of the selected trace.</td>
</tr>
<tr>
<td>Data</td>
<td>Annotation</td>
<td>Select a color and font for display of the trace Annotation(s). The items to be annotated for a trace are selected in the Annotations tab.</td>
</tr>
<tr>
<td>Data</td>
<td>Baseline</td>
<td>Select a color and/or line type for display of the baseline.</td>
</tr>
<tr>
<td>Data</td>
<td>Baseline Start Tick</td>
<td>Select a color and/or line type for display of baseline start ticks.</td>
</tr>
<tr>
<td>Data</td>
<td>Baseline Stop Tick</td>
<td>Select a color and/or line type for display of baseline stop ticks.</td>
</tr>
<tr>
<td>Data</td>
<td>USP Width</td>
<td>Select a color and/or line type for display of the USP Width, if calculated.</td>
</tr>
<tr>
<td>Data</td>
<td>RT Window</td>
<td>Select a color and/or line type for display of expected retention time windows for named peaks.</td>
</tr>
<tr>
<td>Data</td>
<td>RT Window (undet.)</td>
<td>Select a color for display of RT Window for expected peaks that were not detected.</td>
</tr>
</tbody>
</table>
**Change the Axis Properties**

The Axis Setup tab allows you to configure the appearance of the axis on your chromatogram. These settings apply to active traces. To change the Axis properties,

1. In the Chromatogram Window, do a right mouse click and then select **Axis Setup**.

![Axis Properties](image)

**Graph Title**

Enter a title for the graph, if desired. This appears at the top of the graph.
**Axis**

Using the drop-down list, select the axis of interest: Left Y-Axis, Right Y-Axis, or X-Axis. Then for your selection, you can choose the limits for the axis.

For Y-Axis selections, you may choose **Use limits of trace** to get the limits from one of the traces in the window, or you can select the **Manually set trace's limits to** box and set the Y-Axis limits to your desired range. If you choose None, no Y-Axis values will be displayed.

For the X-Axis, you may either choose to **Autoscale**, where the X-Axis is set to the longest trace. Or, you may set an absolute range for the X-Axis by clicking the **Use This Range** button, then enter a minimum and maximum X-Axis value for the trace. Click the **Get Limits** button to retrieve the X-Axis range from the current trace.

**Margins**

Enter a value for the trace margins, in percent, for top and bottom of the graph.

**General Options**

Select the check boxes to turn these graph annotations on and off. If the legend box is selected, the legend for a trace can be turned on or off from the Trace Properties spreadsheet.
Orientation

Select portrait or landscape orientation for your graph by clicking the appropriate button.

Change Data Graph Properties

Whenever a chromatogram or trace is displayed in the Chromatogram Window, it uses the display settings contained
in the Data Graph Properties. To change the Data Graph Properties,

1. In the Chromatogram Window, do a right mouse click and select Properties.
2. Select the tab for the properties you wish to view or change, as shown below

<table>
<thead>
<tr>
<th>Properties tab</th>
<th>Used to</th>
</tr>
</thead>
<tbody>
<tr>
<td>Trace Setup</td>
<td>Add or remove traces, set legends, set scaling.</td>
</tr>
<tr>
<td>Axis Setup</td>
<td>Add a graph title, change data range, set margins and orientation, turn on and off legends.</td>
</tr>
<tr>
<td>Appearance</td>
<td>Set color schemes, line styles, and fonts.</td>
</tr>
</tbody>
</table>

**Set up a trace**

This tab gives you access to adding/removing traces, and setting scaling options for the traces. Each row in the spreadsheet represents one of the traces currently in the chromatogram window. The details of the highlighted trace appear in the trace properties boxes in the bottom of the dialog box where you can view or change them.
Show

Click this box to show the trace in the chromatogram window. De-select this box to remove the trace from the display (but leaving it open). This is a convenient way to temporarily remove a trace from the viewing window.

Lgnd

Click this box to show the legend for the trace. The legend appears in the upper right corner of the window and displays the name of the trace. De-select this box to remove the legend for this trace from the chromatogram window. Setup for the appearance of
the legend (color, etc.) is done in the Appearance tab for the Graph item. Note: If you have not turned on the Legend in the Axis Setup dialog, this box will have no effect.

**Data Source**
Enter the name of the file from which to get the trace. You can also click the File button adjacent to the field and select a data source. The data source can be a chromatogram or it can be a stored profile such as temperature or flow program.

**Current Data**
This selection allows you to select a trace from the current chromatography data.

**Open Data**
This allows you to select a stored data file from which you can select a trace for display.

**Current Method**
This allows you to select a trace from the current method (if available). Examples of traces from a method include temperature profiles for instrument control, for example.

**Trace**
Select the channel to be displayed.

**Scale to**
Select one of the scaling options.

- **Trace x** Scales to another trace in the window.
- **Autoscale to largest peak** Scales such that the largest peak is on scale.
- **Autoscale to 2nd largest peak** Scales such that the 2nd largest peak is on scale.
**Autoscale to 3rd largest peak**  
Scales such that the 3rd largest peak is on scale.

**User Defined**  
Allows you to enter a value for Y max and min.

**Normalized**  
Allows you to normalize one trace to fit on the graph.

**Y min**  
If you have selected a User Defined scale, enter a minimum value for the Y-axis.

**Y max**  
If you have selected a User Defined scale, enter a maximum value for the Y-axis.

**Units**  
Select the units for display.

**X Offset**  
Enter a value in units for offset of the X-axis.

**Y Offset**  
Enter a value in units for offset of the Y-axis.

**Y Scale**  
If desired, enter a multiplier that will be applied to the entire trace here.

---

**Note:**  
You can set the X-axis range from the Rt-mouse click/Axis Setup menu selection.

---

**Annotations**  
Click this button to display the trace annotations dialog.
Hide Details
Click this button to hide the current trace details and display only the spreadsheet.

Reset Scaling
Click this button to reset the scaling values to their original values.

Remove a Trace
If you have multiple traces in your chromatogram window, and you want to remove one or more of them from the chromatogram window, click the right-hand mouse button anywhere within the window, and select the Properties... command. A spreadsheet will appear where the currently displayed traces are listed.

To completely remove a trace from the chromatogram window, select the row by clicking on the # number, then press the Delete key on your keyboard, or select the Edit/Delete command. To temporarily remove the trace from the window, de-select the checkbox in the Show column. Click OK to return to the chromatogram window.

Set Limits for X-Axis and Y-Axis
Occasionally, you may want to set an absolute range for either the X-Axis or Y-Axis, or both. To set limits for the X- and Y-axis,

1. From the chromatogram window, do a right mouse click and then select Properties.
2. Click the Trace Setup tab to set Y-Axis minimum and maximum values for the trace. To set an absolute voltage range for all chromatograms, use the User-Defined option for the Scale To field. You must then enter a Y-Min (minimum Y-Axis value) and Y-Max (maximum Y-Axis value) for each chromatogram. If you want all chromatograms to be displayed using this same voltage scale, enter the same values for all chromatograms.
3. Click the **Axis Setup** tab to set absolute ranges for the trace. Select **X-Axis**, to set the range for the X-Axis. Click **Autoscale** to set the X-Axis range automatically to the range of the longest chromatogram (the default selection), or click **Use this range** to enter an absolute range in minutes. The **Get Current Limits** button brings in the X-Axis range from the current chromatogram window. This is useful because it allows you to use the zoom function to identify the desired region of the chromatogram and automatically enter the range values.

4. Once you have set an absolute range for one or both of these axes, the designated chromatogram(s) will
always be displayed in the chromatogram window using these ranges until you change or reset them.

5. To reset the scaling of all chromatograms to default values, click the **Reset Scaling** button.
13 Chromatogram Operations

About Chromatogram Operations

There are a number of chromatogram comparison and mathematical operations that are available from the chromatogram window. These are accessed by doing a right mouse click in the chromatogram window and then selecting Operations.
<table>
<thead>
<tr>
<th>Operation</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Move Trace</td>
<td>Lets you &quot;grab&quot; and move a trace within the chromatogram window.</td>
</tr>
<tr>
<td>Stack Traces</td>
<td>Positions multiple traces with an offset.</td>
</tr>
<tr>
<td>Align</td>
<td>Adjusts a second chromatogram such that a peak (or point) on one chromatogram will be aligned with a peak (or point) on the first chromatogram.</td>
</tr>
<tr>
<td>Stretch</td>
<td>Performs a two-point contraction or expansion of chromatogram relative to another.</td>
</tr>
<tr>
<td>Normalize</td>
<td>Normalizes one or more chromatograms to the first chromatogram, adjusting the heights such that the apex height of a selected peak matches that of the peak selected on the first trace.</td>
</tr>
<tr>
<td>Smooth</td>
<td>Performs a 9-point Savitsky-Golay smoothing operation on a selected trace.</td>
</tr>
<tr>
<td>1st Derivative</td>
<td>Calculates and displays a 1st derivative of a selected trace.</td>
</tr>
<tr>
<td>2nd Derivative</td>
<td>Calculates and displays a 2nd derivative of a selected trace.</td>
</tr>
<tr>
<td>Add</td>
<td>Adds two traces and displays the result.</td>
</tr>
<tr>
<td>Subtract</td>
<td>Subtracts two traces and displays the result.</td>
</tr>
<tr>
<td>Multiply</td>
<td>Multiplies one trace by another and displays the result.</td>
</tr>
<tr>
<td>Divide</td>
<td>Divides one trace by another and displays the result.</td>
</tr>
</tbody>
</table>
**Move a Trace**

To "grab" a trace and move it with your mouse

1. In the chromatogram window, do a right mouse click and select **Operations** followed by **Move Trace**.

2. Move your cursor over a trace until the cursor changes to a "move" icon.

3. "Grab" the trace by clicking the left mouse button and dragging the trace to a new location. When you release the mouse button, the trace will be placed where your cursor was located when you released the button.

4. "Move Trace" will appear at the upper right corner of the window. You can continue to move traces. When finished, do a right mouse click and select **Operations** followed by the **Move Trace** command again to turn off the move trace operation.

**Stack Traces**

To quickly change the X-axis and Y-Axis offset for a trace

1. In the chromatogram window, do a right mouse click and then select **Operations** followed by **Stack Traces**...

2. Enter a new X-axis and y-axis offset, and click **OK**. The offset will be applied to additional traces displayed in the chromatogram window.
To remove these offsets,

1. In the chromatogram window, click the right mouse button and then select **Properties**.
2. Click the **Trace Setup** tab, then scroll to the right to the X-axis and Y-axis offset columns where you can delete or change these settings.
3. Click the **Reset Scaling** button to restore ALL settings to their original values. Or, you can use the **Stack** command again, entering "0" for both stack parameters.
Align two traces

To Align one chromatogram to another,

1. In the chromatogram window, do a right mouse click, and then select Operations followed by Align. Click first on the point of the first chromatogram to which you wish to align, then click on the peak (or point) of the second chromatogram which you wish to align to the first point. The second chromatogram will be adjusted such that the peak (or point) you clicked second will be aligned with the first point you clicked.

2. To remove the alignment, use the right-hand mouse button/Properties command to view the trace spreadsheet. Click the Trace Setup tab, then scroll to the right to the X-axis and Y-axis offset columns where you can delete or change these settings. Click the Reset Scaling button to restore ALL settings to their original values.

Chromatograms before alignment.
First peak of top chromatogram aligned to first peak on bottom chromatogram.

**Stretch a chromatogram**

The stretch function allows you to perform a two-point contraction or expansion of chromatograms relative to another. To stretch a chromatogram,

1. In the chromatogram window, do a right mouse click and then select **Operations** followed by **Stretch**.
2. Select points (or peaks) on the first chromatogram to which the second will be stretched (or contracted).
3. Select two points on the second chromatogram. The chromatogram between these two points will be stretched or contracted to fit the two points specified on the original chromatogram.

To un-do the stretch,

1. In the chromatogram window, do a right mouse click and then select **Properties**. Click the **Trace Setup** tab, then scroll to the right to the X-axis and Y-axis offset columns where you can delete or change these settings. Click the **Reset Scaling** button to restore ALL settings to their original values.
Chromatograms before stretching.

Bottom chromatogram stretched relative to top chromatogram.

**Normalize Traces**

This function allows you to normalize one or more chromatograms to the first chromatogram, adjusting the heights such that the apex height of a selected peak matches that of the peak selected on the first trace. Once you have selected this command, you will be prompted to select the start and then the apex of a peak in the first trace. Then you will be prompted to click on the start and apex of a peak in the second trace for normalization.
To un-do the normalization, use the right-hand mouse button/Properties command to view the trace spreadsheet. Click the Trace Setup tab, then scroll to the right to the X-axis and Y-axis offset columns where you can delete or change these settings. Click the Reset Scaling button to restore ALL settings to their original values.

Chromatograms before normalization.

After Normalization.
Perform Mathematical Operations on Traces

Performing mathematical operations on traces can be done from within the chromatogram window. To perform a mathematical operation on a trace,

1. In the Chromatogram Window, do a right mouse click and select **Operations**, then select the operation you wish to perform.
2. Follow the instructions displayed to perform the operation. The result of the operation will appear in the window.

For a list of available operations, see **Chromatogram Operations**.

**Smoothing**

To perform a 9-point Savitsky-Golay smoothing operation on a selected data file,

1. In the chromatogram window, do a right mouse click and then select **Operations** followed by **Smooth**. A prompt will appear in the window instructing you to **Click on trace**.
2. Click on the chromatogram to be smoothed. The result trace will appear in the window.

*Chromatogram before smoothing.*
Smoothed result trace is displayed with original trace.

Calculate Derivatives

To calculate and display the 1st or 2nd derivative of a chromatogram,

1. Do a right mouse click on the chromatogram, and then select Operations followed by 1st Derivative or 2nd Derivative. A prompt will appear in the window Click on trace.
2. Click on the chromatogram for which you wish to perform the operation. The result trace will appear in the window.
Trace before 1\textsuperscript{st} derivative.

1\textsuperscript{st} derivative trace displayed with original trace.
Add two traces

To add two traces to a chromatogram window,

1. In the chromatogram window, do a right mouse click, and select **Operations** followed by **Add**.
2. Click on 1st trace to select the first file by clicking the mouse on the chromatogram.
3. Click on the 2nd trace to select the trace to be added to the first by clicking on the trace with the mouse. The result trace will appear in the window. Note that in order for this operation to be valid, both traces must have the same sampling frequency.

Subtract two chromatograms

To subtract two traces,

1. In the chromatogram window, do a right mouse click and then select **Operations** followed by **Subtract**.
2. At the prompt, click on the 1st trace. Select the first trace by clicking the mouse on the chromatogram.
3. Select the trace to be subtracted from the first by clicking on the trace with the mouse. The result trace will appear in the window.
Note: In order for this operation to be valid, both traces must have the same sampling frequency.

Multiply Traces
To multiply two traces,

1. In the Chromatogram Window, do a right mouse click and select Operations followed by Multiply.
2. Select the first trace by clicking the mouse on the chromatogram or trace.
3. Select the trace to be multiplied by the first by clicking on the 2nd trace with the mouse. The result trace will appear in the window. For the multiply operation, the units of the resulting trace are <trace 1 units> x <trace 2 units>.

Divide chromatograms or traces
To divide two traces,

1. In the Chromatogram Window, do a right mouse click and then select Operations followed by Divide.
2. A prompt will appear in the window Click on 1st trace. Select the first trace by clicking the mouse on the chromatogram.
3. A second prompt Click on 2nd trace will appear. Select the trace to be divided into the first by clicking on the trace with the mouse. The result trace will appear in the window. The equation used to calculate the result trace is as follows.

\[
p = \left( \frac{y_1}{\sqrt{y_1^2 + y_2^2}} \right) + y_{muls}
\]

Where
p = the calculated point for the result trace at time t
y1 = a point from the first trace at time t
y2 = a point from the second trace at time t
ymult = the y multiplier for the trace that converts it from microvolts to the trace's displayed units

Utilities

About Chromatogram Utilities

The Utilities menu in the chromatogram window gives you access to commands for saving, copying, or printing the current chromatogram window. To access the Utilities, in the Chromatogram Window do a right mouse click and then select Utilities.

<table>
<thead>
<tr>
<th>Utility</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Print</td>
<td>Sends the current chromatogram view to the printer.</td>
</tr>
<tr>
<td>Copy to Clipboard</td>
<td>Copies the contents of the chromatogram window to the clipboard.</td>
</tr>
<tr>
<td>Save Trace...</td>
<td>Prompts you to click on a trace then opens the save data file dialog.</td>
</tr>
</tbody>
</table>
Print a trace
This command sends the current chromatogram window view to the printer.

Copy to clipboard
To copy the contents of the window to the clipboard,

1. From the chromatogram window, do a right mouse click and select Utilities followed by Copy to clipboard.

This command copies the current chromatogram window to the clipboard as a metafile. From here, you can paste the view into a word processing document or other application that supports the clipboard. Note: To paste into Microsoft Word, you need to use the Edit/Paste Special/Picture command.

Save a trace
Use this utility to save a trace as a data file.

1. From the Utilities menu, select Save Trace.
2. Click on the trace you wish to save.
3. In the Save Data File As dialog, browse to the location for saving the file and type the name for the file.

14 Graphical Programming

About Graphical Method Programming
The Graphical Programming menu enables you to add timed events and set up other method parameters graphically by clicking on the displayed chromatogram. These commands are also available from the Graphical Programming Toolbar, which is displayed by default at the bottom of the Instrument Window. To turn on the Graphical Programming Toolbar,

1. From the menu, select View followed by Preferences.

2. Select Int Events and then select Toolbar.
Parameters that can be set using graphical programming include:

<table>
<thead>
<tr>
<th>Command</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Width</td>
<td>Inserts a Width event at the point on the chromatogram.</td>
</tr>
<tr>
<td>Threshold</td>
<td>Inserts a Threshold event at the point on the chromatogram.</td>
</tr>
<tr>
<td>Shoulder Sensitivity</td>
<td>Inserts a Shoulder Sensitivity event at the point on the chromatogram.</td>
</tr>
<tr>
<td>Integration Off</td>
<td>Turns off integration at the point on the chromatogram.</td>
</tr>
<tr>
<td>Valley to Valley</td>
<td>Turns on valley to valley baseline detection.</td>
</tr>
<tr>
<td>Horizontal Baseline</td>
<td>Forces a horizontal baseline from the point on the chromatogram.</td>
</tr>
<tr>
<td>Backward Horizontal Baseline</td>
<td>Forces a backward horizontal baseline from the point on the chromatogram.</td>
</tr>
<tr>
<td>Lowest Point Horizontal Baseline</td>
<td>Forces a horizontal baseline at the next lowest point.</td>
</tr>
<tr>
<td>Tangent Skim</td>
<td>Forces a tangent skim.</td>
</tr>
<tr>
<td>Front Tangent Skim</td>
<td>Forces a front tangent skim.</td>
</tr>
<tr>
<td>Minimum Area</td>
<td>Set a minimum area for peak detection.</td>
</tr>
<tr>
<td>Negative Peak</td>
<td>Turn on negative peak detection.</td>
</tr>
<tr>
<td>Disable Peak End Detection</td>
<td>Disables the end of peak detection.</td>
</tr>
<tr>
<td>Reassign Peak</td>
<td>Designates a different peak as the calibrated peak.</td>
</tr>
<tr>
<td>Manual Baseline</td>
<td>Manually define a baseline.</td>
</tr>
<tr>
<td>Manual Peak</td>
<td>Manually define the beginning and end of a peak.</td>
</tr>
<tr>
<td>Split Peak</td>
<td>Force a perpendicular to split a peak.</td>
</tr>
<tr>
<td>Force Peak Start</td>
<td>Force the start of a peak.</td>
</tr>
<tr>
<td>Function</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------------</td>
<td>-------------------------------------------------------</td>
</tr>
<tr>
<td>Force Peak Stop</td>
<td>Force the end of a peak.</td>
</tr>
<tr>
<td>Move Baseline</td>
<td>Manually move a baseline.</td>
</tr>
<tr>
<td>Reset Baseline</td>
<td>Force a baseline to the point.</td>
</tr>
<tr>
<td>Reset Baseline at Valley</td>
<td>Reset the baseline to the next valley.</td>
</tr>
<tr>
<td>Adjust Retention Time Window</td>
<td>Adjusts the retention time window.</td>
</tr>
<tr>
<td>Adjust Group Range</td>
<td>Adjust the group range.</td>
</tr>
<tr>
<td>Define Single Peak</td>
<td>Define a single peak and add it to the peak calibration table.</td>
</tr>
<tr>
<td>Define Peaks</td>
<td>Define multiple peaks and add them to the peak calibration table.</td>
</tr>
<tr>
<td>Define Groups</td>
<td>Define groups and add them to the group calibration table.</td>
</tr>
<tr>
<td>Suggest Sampling Frequency</td>
<td>Suggest a sampling frequency for the chromatogram.</td>
</tr>
</tbody>
</table>
15 Data Acquisition and Control

Data Acquisition and Control

Commands that are available from the Control menu are related to data acquisition and control of the instrument. In general, there are two ways to acquire data: 1) single run acquisition, where you acquire data for a single injection and 2) sequence acquisition, where you acquire data automatically for a series of runs using a pre-programmed sequence that defines the number of injections, methods, file names, and calibration. Additional control menu items will appear depending on the features supported by the instrument configured.

Single Run Acquisition

There are two ways you can acquire data. One way is with a sequence (for multiple runs), and the other way is to make a single run. To make a single data acquisition run, you need to specify the method to be used for analysis, and a file name for data storage.

Note: In order to use a method for data acquisition, its Instrument Setup should have the acquisition channel turned On, and a sampling rate and run time designated.

To make a single run, click the Single Run button, or select the Control>Single Run command from the menu. A dialog will appear.
Run Information

This section allows you to specify files for the run.

Sample ID

Enter a Sample ID for the run. This can contain text and numbers, and is saved with the data file. You can also click the arrow and select from a number of predefined ID’s.

Method

Enter the name of the method to be used for data acquisition and processing. Include the entire path name if the method is not in your default method directory. You can select the method from a list of methods available on your disk by clicking the File button adjacent to the field.

Data Path

Enter a path name where the data acquired for this run will be stored. Click the File button to select a path from a list of those on your disk.

Data File

Enter a file name to be used to save the data on disk. You can select from one of the pre-defined name types by clicking the arrow button adjacent to the
field. It is not possible to use an existing file name, unless the file exists in located in a directory whose path contains the term "public". For example, if you data files are saved in a directory entitled "C:\Public\Data", the files saved in this directory can be overwritten. The software automatically appends a .dat file extension.

**Number of runs**

Enter the number of runs you wish to make. The runs will automatically proceed without review until completed, incrementing each file name as designated. If the sequence of single runs is aborted, and the user then repeats the single acquisition without changing any parameter, the run number will start with the next number as if the sequence not been aborted. For example, setting 4 runs with starting run number of 101, then abort during run 102. When restarting, the next run number will be 105. If the Sample ID is also incremented, it will increment in parallel.

**Print Method Report**

When this box is checked, the method report (or reports) will be printed at the end of the run.

**Amount Values**

In this section, you can enter values that affect how the concentrations are calculated. If you are making a single data acquisition prior to calibrating your method, simply leave these values at the default level.

**Sample Amount**

The Sample Amount value is used as a divisor during calculation of concentrations. It is intended to compensate for differences between samples due to weighing and when percentages of the total sample are being calculated rather than the amount detected in an injection.
**Internal Standard Amount**

For calibration runs, the Internal Standard Amount is taken from the method Peak Table. For unknown runs, enter the amount of the Internal Standard in your unknown sample.

**Multiplication Factors**

Enter one to three multiplication factors to be used for this run. All quantitated peaks will be multiplied by these factors.

**Dilution factors**

Enter one to three dilution factors to be used for this run. All quantitated peaks will be divided by these factors.

**Calibrate**

Select this box if the sample is to be a calibration sample. Once this box is clicked, the following fields and options will be available.

**Calibration Level**

Enter the number of the calibration level represented by this calibration standard. If this is a single level calibration, enter 1.

**Clear all calibration**

Click this box if you want to clear all existing calibration factors from your method before running the sample.

**Clear calibration for level**

Click this box if you want to clear the existing response factors for this level only before running the sample.

**Print calibration report**

Click this box if you want to print a calibration report after running the sample.
Clear replicates
Click this box if you want to clear all existing replicates from the existing calibration level before running the sample.

Average replicates
Click this box if you want to average the replicates for this calibration level.

Baseline Check
This box will appear if you have the Baseline Check option implemented in the instrument configuration. When this box is checked, it will trigger a baseline check prior to the start of the run.

Begin run
By default, run will start immediately. If you want to schedule the start of the sequence for a later time or date, click the button to open the Schedule Run dialog where you can enter or select the time to start the sequence.

Startup/Shutdown
For instruments that support it, boxes for Startup and Shutdown will appear in the dialog. These boxes enable you to designate the run as either a Startup or Shutdown sample. When one of these boxes is checked, it will trigger the Startup or Shutdown routine on your instrument. For details, see the control documentation for your instrument.

When you have completed the Single Acquisition Run dialog box, click Start to begin the acquisition. The current data will appear in the chromatogram window as it is acquired and stored on disk. At the end of the run, the chromatogram will be analyzed according to the method parameters, and a report generated if specified. If the sample is not analyzed at the end of the acquisition, click the Analyze button if you wish to view the results.
Run a Sequence

Once you have created and saved a sequence, you can use it to acquire and process data. To start a sequence acquisition,

1. From the Instrument Window, click the Sequence Run button, or from the Control menu, click Sequence Run....

2. Enter or select a sequence to use, set a run range, mode, printing options and review options, then click Start.

Sequence Information

Enter the Sequence Name to be used, or select the sequence file from a list of available sequence files by clicking the File button.

Run Range

Select the range of the sequence to be run.

All
Click this to execute all runs in the sequence.

Selection
If you have currently selected a series of runs in your sequence spreadsheet by highlighting them, click this to run only the highlighted runs.
Range

Enter a range of runs to be executed. For example, an entry of 4 - 6 will execute runs 4, 5, and 6 of the sequence. An entry of 4- designates the 4th run through the end of the sequence.

Mode

Select the manner by which you want to handle autosampler dual towers (if any), processing mode, and bracketed calibration (if used).

Tower

If your instrument is configured for Dual Tower, you can select the tower mode to be used for the sequence run. Selections include Dual, Front, and Rear.

Processing Mode

Select a mode for reprocessing the data. Options here will vary depending on the instrument configured. If the instrument does not support this feature, this option will be grayed out. For certain instruments, Overlap Sample Prep mode will be available. See About Overlap Sample Prep for information and restrictions for using this mode.

Bracketing

Select the type of bracketing you wish to perform. (See Bracketed Calibrations for details.)

None Select this if you do not wish to bracket calibrations.

Standard Select this if you wish to perform the standard mode of bracketing calibrations.

Std. w/Clear Calib Select this if you wish to perform the standard mode of bracketing calibrations, clearing the calibration before the start of each calibration set.

Sequence Select this if you want to perform the sequence mode of bracketing calibrations.
**Seq. w/ Back Calc** Select this if you want to perform the sequence mode of bracketing calibrations and back-calculate calibration runs.

**Review**

**Results Review**
Click this box if you want the sequence to pause between runs for you to review results.

**Calibration Review**
Click this box if you want the sequence to pause after each calibration set, where a calibration set is defined as one or more calibration runs that occur in a sequence.

**Printing**

**Print Method Reports**
Click this box if you want the custom report defined in the method to be printed for each run of the sequence.

**Print Sequence Reports**
Click this box if you want sequence reports to be printed.

**Begin run**
By default, run will start immediately. If you want to schedule the start of the sequence for a later time or date, click the button to open the Schedule Run dialog where you can enter or select the time to start the sequence.

**Email Recipient(s)**
Use this field to enable email notification to be sent to a designated address (entered in the To: field).
Select the On Start box to send email notification when the sequence starts.
Select the **On Stop or Error** box to send email notification when the sequence stops or if an error occurs.

When you have completed the dialog box, click **Start** to initiate the sequence acquisition. You may see the data displayed in real time in the chromatogram window(s), if the "current data" is selected for viewing.

**Stop a Run in Progress**

When you want to stop data acquisition during a run,

1. Click the STOP button that appears on the command ribbon when the run is in progress, or from the **Control** menu, click **Stop Run**.

2. Select how you want to stop the run. If you are running an instrument connected to an Agilent Instrument Controller, you will not be able to stop the run or sequence unless you are the user that submitted it.

---

**Note:** When using the STOP button, make sure to hold the mouse button down until the STOP button icon changes to the "depressed" appearance before releasing.

---

**Stop current run only**

Select this to end the run currently in progress. If the run is a part of a currently-queued sequence, the sequence will continue with the next run.
**Stop current run and sequence run**
This selection stops the run currently in progress, and terminates the sequence it is a part of. Other queued items will proceed.

**Stop sequence after current run completes**
This selection will abort the sequence after the current run in progress is completed.

**Stop all run queue items you submitted**
This selection stops the run currently in progress, and terminates all the items in the queue that were submitted by you. Queue items submitted by other users will be unaffected.

**Stop all run queue items**
This selection stops the run currently in progress, and terminates all items in the run queue.

---

**Note:** When a run is stopped, the data up to that point is saved in the data file. However, no analysis of the data will be performed. If you want to produce a report or view results from a run that was stopped, you must Analyze the data file.

**Note:** If you are not the user that submitted the run or sequence or are using an instrument offline, you do not have access to the Stop command.

---

**Extend a Run**
While a run is in progress, you can extend the data acquisition beyond the designated run time by

1. From the menu, click **Control** followed by **Extend Run**.
2. A dialog will appear where you can enter the amount of time by which you wish to extend the run.
3. Enter the number of minutes you wish to extend the run, and then click the **OK** button.
Note: If you are not the user that submitted the run or sequence or are using an instrument offline, you do not have access to the Stop or Extend Run command.

16 Turn Off GPIB Instruments

If you are using two instruments attached to a GPIB board, it is important to close the instrument application (or close the instrument window and then close the server) prior to turning off the power to the instrument or instrument modules, otherwise the other instrument attached to the GPIB board may freeze.
17 Tutorial

This section walks you through the basics of using EZChrom Elite. Follow the steps to set up a method and acquire a data file, then optimize the method for integration and set up calibration. Use the Tutorial files provided with the software to "play" with the software and become comfortable with its use. Details on data file structure, application window features, how to open and save files are located in Basics of Operation.

Note: This Tutorial assumes that EZChrom Elite is installed with all an analog instrument using an SS420x installed and properly configured. If you have a digital instrument configured, refer to the online help to complete the instrument setup for data acquisition.

Tutorial Overview

The following list gives you a quick view of what the Tutorial section contains. If you are just starting to use EZChrom Elite, you should perform all steps in the Tutorial, in the order presented.

Step 1: Create a Data Acquisition Method

- Set up acquisition run time and sampling rate
- Save the method
- Run a preliminary sample
- Set Integration parameters graphically

Step 2: Create a Single-Level Calibration

- Name Calibrated Peaks
- Run a Single-Level Calibration

Step 3: Create and Run a Sample Sequence
Step 4: Using Tutorial Files

- Review a Multi-level Calibration
- Explore a Peak Table
- Examine a Custom Report
- Change integration parameters

18 Tutorial - Acquiring and Analyzing Data

In this section of the Tutorial you will use the data system to acquire data and optimize the integration, set up and run a calibration standard, and create and run a sample sequence. Details for advanced operation are located in later sections of this manual.

Instrument and Method Wizards

To make using the system easy, you can use the built-in Instrument and Method Wizards. These Wizards make it easy to locate and step through the dialogs necessary to create or modify methods. If you use the Method Wizard to create your Tutorial methods, use the wizard buttons to move you to the dialog associated with the Tutorial step you are on.

The Method Wizard is started from the Instrument Wizard box by clicking the button labeled **Create or modify a method**.
When you click this button, the Method Wizard will appear, allowing you to select how you want to use the wizard.

Select the **Create a new method** button to start creating your tutorial method.
When you select this button, the Method Wizard sets up a bank of buttons in your application window that allow you to "step" through all dialogs of method generation. A save button is also provided.

Create a Data Acquisition Method

The first step toward acquiring a data file is to create a data acquisition method. At this point, you merely need to make sure that the method will acquire the data for a long enough run time for your last peak to elute, using the default data acquisition sampling rate (which is adequate for most samples except for fast capillary runs.)

Note: You can skip this step and use data and method files provided if you do not currently have access to an instrument.

Acquisition Setup

To set your acquisition run time and sampling rate, go to the Acquisition Setup dialog. This is the first dialog displayed if you are using the Method Wizard. Or, click on Method/Instrument Setup, or click the Instrument Setup button on the command ribbon. A dialog box will appear. Be sure to click the box adjacent to Acquisition Channel On to turn on data acquisition for this channel.

Note: If you are using an instrument control option, one or more tabs will appear in Instrument Setup that provide instrument-specific options. See the online help for that instrument for details.
The default **Sampling Frequency** should be adequate for most types of chromatography. For **Frequency** data sampling, the data rate is selected in Hz (samples per second). For **Period** sampling, you can select the number of seconds (or milliseconds) between data points. The default is **Frequency** and this is how most chromatography applications are set up.

Make sure that the **Run Time** is long enough for your last expected peak to elute. If you do not know how long it will take to elute, set the run time to a high number, such as 100 minutes. (You can stop the run manually after the last peak has eluted.) After your first run you can then adjust the run time to a more appropriate number.

Click the **Trigger** tab and select the **Trigger Type** for the type of remote start (if any) you have installed for the instrument you will be using. (If no trigger is configured, this tab will not appear.) The trigger for each instrument is set up during configuration.
None  Sampling of data starts immediately when Start is clicked.

Manual  User must start the data sampling.

External  Data sampling starts when externally triggered.

When you have completed the acquisition setup information, click the X box in the upper right hand corner of the tab window to exit the dialog.

**Save Your Method**

Once you have set the acquisition parameters, save your method using a name you will recognize. Click on **File>Method/Save As...** A dialog box will appear.
Select the folder in which you want to save your file. In the **Filename** field, type Test.met as the filename for saving the method.

**Run a Preliminary Sample**

You will now use the data acquisition method you just saved to make your first data acquisition run. To aid in later steps of the Tutorial, it is best to run a standard sample for your first acquisition run.

1. To start the run, select **Control>Single Run** or click the **Single Run** button.
2. At this point, enter **Test** in the **Sample ID** field.

3. In the Method field, either type your method name, along with its path, or select the **Test.met** file from a file list on your disk by clicking on the open file button adjacent to the field.

4. Enter a path for storage of data files in the **Data Path** field, or select a path from a list presented by clicking the open file button adjacent to the field.

5. Enter **Test.dat** as the name for storing your data in the **Data File** field. You must enter a unique file name in this field. Therefore, if you have performed this tutorial before, you must first delete this file from your disk, or move it to a different directory before proceeding.

6. Since you are not doing calibration at this point, simply click **Start** and inject your standard sample. You will see the data as it is acquired in the chromatogram window on your screen.

**Set Integration Parameters Graphically**

EZChrom *Elite* uses default integration parameters that are appropriate for most simple chromatography. However, you may have certain peaks that require special integration treatment. Such special integration treatments are entered
into your method as **Integration Timed Events**. These events can be placed at the beginning of the run to apply to all peaks, or they can be inserted at a certain place in the chromatogram such that only some peaks are affected. Follow the steps below to add the timed event to turn off integration to your method.

*Note:* You can perform this step using one of the **multi calibration level.dat** files provided with the software.

1. At this point, your recently acquired chromatogram should be displayed in your chromatogram window. If it is not, click the Open File button, select Open Data, and then select your data file from the list displayed. Alternatively, you can select one of the files supplied with Elite.

2. Click the Analyze button to integrate the chromatogram and display the baselines.

*Note:* If you don’t know what a button’s function is, simply move the cursor over the button (don’t click) and a Tooltip box will appear showing the button’s name or function.

3. To add the Integration Off timed event, click the Int Off button on the Toolbar. As instructed in the status bar at the bottom of the window, click your mouse once prior to a part of the chromatogram where you want to turn integration off. (Select a section of chromatogram where one or more peaks elute.) Then click the mouse again at the point on the chromatogram where you want to turn integration on again. A dialog will appear.
The points where you clicked your mouse are shown as **Start Time** and **Stop Time**. The integration will be turned off between these points on your chromatogram. The **Value** is set at zero, as no numeric value is required for this event. Click **Analyze Now** to add the event to the method and re-integrate the chromatogram. (**Add to Table** will simply add the event to the integration timed events table without re-integration.)

Select the button next to **Insert into Integration Events table** and the event will be added to the Integration Events Table of your method (where it will be used on all chromatograms analyzed using this method). Select the button next to **Insert into Manual Integration Fixes table** and the event will be added to the Manual Integration Fixes Table of the present chromatogram (where it will be applied only to this chromatogram).

Your chromatogram will be re-drawn using the new integration event. Notice that the area you selected has no baselines drawn because the integration has been turned off for these peaks.

4. The integration event is put into the Integration Timed Events table. To view this table, click the **Integration Events** button on the command ribbon. Your integration timed events table will appear. Notice the Integration Off timed event has been added to the table.

5. To remove the Integration Off event from your method, click on the **Integration Off** event name or
the row number, then press the Delete key on your keyboard. You can also delete the event using the Edit/Cut command. Using this command, you could re-insert the event using the Edit/Paste command if you wished. To temporarily view the effect of removing an event without actually removing it from the table, click the check box adjacent to the event to de-select it. To re-select the event, click the check box once again.

6. When you are finished with the Integration Events table, click the X box to close it and return to your chromatogram.

Create a Calibration

If you are interested in peak quantitation (calculation of results based on the running of standards), you must set up your method for calibration. Further details on how to set up multiple level calibrations are given in the Method Development section of this manual. For this tutorial, however, you will set up a single level of calibration.

Setting up any type of calibration involves the following steps.

- Identify the Calibrated Peaks and enter standard amounts in the method
- Run the standard sample(s)
- Review the calibration curve

The easiest way to enter calibration peak data is to actually run the standard sample first, then use the stored data file to graphically define your calibration peaks. If you have been following the Tutorial, you should already have a standard sample saved on your disk. If you do not, you can either run a standard sample using the steps shown above in the Run a Preliminary Sample section of this Tutorial, or you may select one of the data files provided with the data system.

1. Open your stored data file by clicking the Open File button and select Open Data... Select your standard data file from the list, or select one of the data files. Once the file is displayed in your current data chromatogram window, click the Analyze button to
integration the chromatogram and show the baselines.

2. Click the **Define Single Peak** button on the Toolbar. A dialog box will appear for the first detected peak in the chromatogram.

![Define Single Peak Dialog](image)

The retention time of the first detected peak will appear. If you want to add this peak to the peak table, complete the dialog for this peak. If you do not wish to add this peak to the peak table, click the **Next** button. If you want to move to a specific peak in the chromatogram, click on that peak with your mouse. The retention time shown in the dialog will change to reflect the selected peak.

**Peak Name**

Enter the name of the compound in this field.

**Conc Level**

Concentration Level 1 is shown. Enter the amount of this compound for this concentration level. (Note: For setting up more than one level for this compound, you...
would enter Concentration Level 2 and the amount for that level. Continue to enter level concentrations until you have completed the number of calibration levels desired.)

**Units**

Enter the units to be used for display of results.

**ISTD ID #**

If you are doing internal standard calibration, enter the ID # for the internal standard peak for this compound. This is the peak ID number from the peak table. If you don’t know it, you can add it in the peak table later.

**Ref ID #**

Enter a retention time reference peak ID # to be used for this peak. This is the peak ID number from the peak table. If you don’t know it, you can add it later in the peak table. Reference peaks are used to locate calibrated peaks when chromatographic conditions change such that retention times shift.

**Retention Time Window**

Select how you want to enter the retention time window for this peak. The window is used for peak identification in case of slight deviations from the expected retention time.

**Relative**

Click this if you want the system to calculate the retention time window based on a % of the expected retention time of the peak. Enter the % you want to use for calculation of the window.

**Absolute**

Click this if you want to enter an absolute window for the peak. Enter the value you want to use for the retention time window, in minutes.

3. Click **Next** to move to the next detected peak. Click **Back** to move to the previous detected peak in the chromatogram. The current peak and total peaks in
the chromatogram is displayed on the right of the dialog box. When you are finished adding peaks to your peak table, click Done. Each peak you defined will become a row in your peak table. Note that if you already had peaks in your peak table, the peaks you just defined will be added to those already present. To view the peak table, click the Peak/Group Tables button from the command ribbon.

4. Once you have defined your peaks, click the Peak Table button and the calibration peak table will appear. Make sure the Named Peaks tab is selected. Each peak you defined will appear as a row in the Peak Table spreadsheet, along with its retention time and other parameters you entered.

![Peak Table Spreadsheet](image.png)

Information in the spreadsheet can be edited or changed by scrolling through the rows and columns. Details on contents of the Peak Table are described in the calibration section of this manual.

5. Do not enter information in the other columns at this time. Close the Peak Table by clicking the X box in the upper right corner of the spreadsheet window.

Your method is now ready to be calibrated. Before you proceed, save the method on your disk. To do this, click the Save button followed by Save Method, or select File/Method/Save from the menu. (If you wish to save the method using a different name, use the File/Method/Save As command.)
Calibrate Using a Stored Data File

In order for the software to calculate amounts for unknown samples, your method must contain the areas generated for each component in your standard sample. In order to get these areas into your method, you can either run the standard sample again, designated as a calibration run, or you can calibrate the method using the stored run from before, using the Analysis>Single Level Calibration command. To use the stored data file to calibrate the method, follow the steps outlined below.

2. Select Analysis>Analysis Single Level Calibration from the menu bar. A dialog box will appear where you must designate file information for your calibration.

2. Enter the sample identification in the first field. If you are following the tutorial exactly, this will be Test.

3. Enter the name of the method you want to calibrate, including full path name. If you aren’t sure of the method name, select it from a list by clicking the Open File button adjacent to the field. The Tutorial method is Test.met.

4. Enter the data path name, or select it from the list using the open file button.

5. Enter the name of the calibration data file in the Data File field. The open file button lets you select the file name from the disk. The name used in the Tutorial is Test.dat.
6. Leave the Amount Values set to "1". For details on how these values are used, see Method Development.

7. Click on the Calibration checkbox, then enter a "1" for Calibration Level. Since this method is currently uncalibrated, it is unnecessary to select any of the boxes dealing with calibrations or replicates. However, if you are unsure of the method contents, click the Clear all calibration box before starting.

8. When you have completed the dialog, click Start. When the analysis is complete, the chromatogram will be integrated, and the areas for the peaks identified as calibration compounds will be entered into the method. The calibration curves will be generated using these areas. At this point, the method is calibrated for a single level, and it can now be used to run and analyze samples with the calibration compounds in unknown amounts.

Create and Run a Sample Sequence

If you are using an autosampler to inject samples, you must define the samples to be injected and how they are to be acquired and analyzed. This is done using a sample Sequence. A sample Sequence can be used to acquire both calibration and unknown samples. It can also be used to automatically re-analyze stored data files. Details on creating and using a Sequence are located in the Sequence section. In this part of the Tutorial you will create and use a simple sequence to acquire a calibration sample and two or three unknown samples.

3. 1. To create a new sequence, click the File>Sequence>Sequence Wizard command. A Sequence Wizard dialog box will appear.
4. Type the method to be used for the acquisition, or select the name from a list of available methods by clicking the File Open button.

5. For Method, enter the method name (including path) for the method you have been using for this Tutorial. If you don't know the entire path name, you can select it by clicking the file button next to the field, and selecting your method name from the list displayed. If you are following the Tutorial, enter Test.met as your method name. Leave the Amount values at their default values.

6. Click the For Acquisition button. This will cause the Sequence Wizard to prompt you for information required for data acquisition. Then click Next.
7. The **Sample ID** field is for an identification for the samples. Click the blue right arrow and select the **Line number** and **Method name**. This will cause each sample to be identified with the sequence line number and current method name.

8. In the **Data Path** field, enter the path where you want the data to be stored, or select an existing path by clicking the **File Open** button.

9. For **Data File**, click the blue right arrow, and select **Sample ID**. This will cause the data files to be named by the sample ID you selected above. Using a numbered identification ensures the data file name for each run is a unique name, preventing errors that will occur if you try to acquire data using an existing data file name.
8. For number of unknown runs in sequence, enter 3. Leave the other fields at default values.

9. Click Next to continue.

10. In this dialog, the calibration ID and calibration file names are automatically set to the identifications from the previous dialog. Set the number of calibration levels to "1", and leave the calibration repetitions per level at "1" also. Leave all other boxes unchecked, then click Next.
13. Select the check boxes to cause the samples to be included in a summary report and calibration summary report. Do not select the other boxes.

14. Click Finish. A sequence spreadsheet will appear, with the file and method names you specified shown.
15. At this point, the sequence is set up to run 1 calibration sample and 3 unknown runs. Notice the Sample ID’s and Data File names are numbered automatically to prevent duplication. In order to run a calibration standard as the first run, you must designate that run to be a calibration run. This has been done automatically by the Sequence Wizard. Unknown runs always have a Level of "0". The information in the Run Type field may be abbreviated if there is more than one run type designation. To view the possible Run Types, click the arrow next to the run type. For details on each of these run types, see the Sequence section. Since the method we have been creating in this Tutorial is a single level calibration, only one calibration standard run is necessary.

16. To save the sample sequence file, click the Save Sequence button to go to the Save Sequence dialog box, or use the File/Sequence/Save As command from the menu bar. Select the C:\datasystem\Sequence folder (where datasystem is your program installation folder), then enter the name Test or Test.seq for your sequence file name.

---

Note: By default, sequence files are saved with the .seq extension.

---

**Run a Sequence**

To acquire data using the sequence file you just created, click the Sequence Run button on the command ribbon, or do a right-hand mouse click in the sequence spreadsheet, and select Run Sequence. A dialog box will appear.
Enter the name of your sequence file by typing the name, along with path, in the **Sequence Name** field. You can also select it from a list of sequence files on your disk by clicking the file button next to the field. Leave the other parameters as their defaults.

Prepare your autosampler to inject your standard sample, followed by 3 unknown samples. When you are ready to inject your first sample, click **Start**. When the sequence is completed, you will have acquired and saved the data files for one standard and three unknown runs, and generated a simple result report for each unknown sample and a summary report for the sequence.

Because you have not yet defined a sequence summary report, do not check the Print sequence reports box.

### 19 Using the Tutorial Files

In this section of the Tutorial, you will use the tutorial files provided to become familiar with additional features of the Data System.

**Review Multi-level Calibration Curves**

Once you have fully calibrated a method, the calibration curves and associated data can be viewed using the **Review Calibration** function. In order to see a fully calibrated multi-
level calibration, use the **multilevel calibration.met** file provided with the data system.

1. Open the **multilevel calibration.met** method file by clicking the **Open** button followed by **Open Method**. Select the **multilevel calibration.met** file from your disk. It will be located in the \datasystem\Methods folder. (Where datasystem = your installation program folder.)

2. Once you have opened the **multilevel calibration.met** method, click the **Review Calibration** button, or select the **Method/Review Calibration** command. The following window will appear.

```
<table>
<thead>
<tr>
<th>Peak</th>
<th>Area 1</th>
<th>Area 2</th>
<th>Area 3</th>
<th>Area 4</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>5684</td>
<td>1234</td>
<td>3456</td>
<td>7890</td>
</tr>
<tr>
<td>2</td>
<td>2345</td>
<td>1234</td>
<td>3456</td>
<td>7890</td>
</tr>
<tr>
<td>3</td>
<td>5684</td>
<td>1234</td>
<td>3456</td>
<td>7890</td>
</tr>
</tbody>
</table>
```

The calibrated peaks in the method are listed in the peak list at the top right corner of the window. The calibration curve shown is for the peak that is highlighted. You can view the other curves by highlighting their peak name. At the top of the screen is a spreadsheet that displays all the calibration information, including areas used to create the current calibration curve.

3. The calibration curve fit type by default is Point-to-Point. To overlay a different fit type, click the right mouse button anywhere in the calibration curve box. Select **Fit Type** and then select **Linear**. Notice the new linear calibration curve is overlaid on the Point-to-Point curve. In the box at the right, the equations...
for the different fit types displayed are shown, along with the goodness of fit calculation, $r^2$, which is not calculated for the Point-to-Point curve since it is by definition a perfect fit to the data.

For additional details on using **Review Calibration**, see **Method Development**. To close the window, click the X box at the upper right corner of the Review Calibration window.

### Explore a Peak Table

The Peak Table is where method calibration information is located. In this section, you will use a method provided with the software to examine a Peak Table and become familiar with what a completed peak table looks like.

1. Open the **multilevel calibration.met** method which is located in the c:\datasystem\Methods folder (where **datasystem** is your program folder), by clicking the **File** button, followed by **Method**, then selecting the c:\datasystem\Methods\multilevel calibration.met method from the list of methods on your disk.

2. Once the **multilevel calibration.met** method is open, view the Peak Table by clicking the Peak Table button on the command ribbon. A peak table will appear.

3. On the **Named Peaks** tab, you will find a table containing all of the calibration information for the calibrated peaks in this method. If you scroll to the right, you will see many different columns, each of
which represent a parameter for the calibration, including the Levels, which contain the calibration amounts for each compound at each level of calibration. Note that it is possible to customize the Peak Table such that only parameters needed for a given calibration are displayed. Details on what each column represents, along with how to customize the Peak Table, are given in the Method Development chapter of this manual.

Examine a Custom Report

A complete suite of report templates are provided that can be used without modification to generate reports. To see an example of one of these reports, use the Reports>View>External Standard Report command from the menu bar. (Make sure your current chromatogram has been analyzed first.) The standard report will appear in a window on your screen.

If your method contains no defined custom report, the system will use the standard report formats to print reports when required.
If you wish, you can modify the standard report templates, or create entirely new reports using the Custom Report feature. You can create custom method reports and / or custom Sequence reports. These are described in detail in the **Custom Reports** section.

To view the custom report template in the **multilevel calibration.met** file, first open the file if it is not already open. (Use the File Open button, followed by Method, then select it from the file list.) Click the **Edit Custom Report** button on the command toolbar to access the method custom report editor. The current method custom report template will appear.

Examine the custom report template by scrolling through it using the scroll bars that appear on the bottom and side of the window. Before you attempt to edit or create your own custom report, you should thoroughly review the **Custom Report** section. To return to the method, click the x box in the upper right corner of the custom report window.
Changing Integration Parameters

Another important aspect of using a computerized data system is the ability to customize the integration using Integration Timed Events. In this part of the Tutorial, you will use the multi calibration level 3.dat data file provided to become familiar with how to enter integration timed events into your method, and to view the effects of some of these events. Complete details on how each integration timed event works are given in the Integration section.

1. Open the multi calibration level 3.dat data file by clicking the File button, followed by Data Files, then select the Multical3.dat file from the \Data folder on your disk. Select the Open with Method option to open the multilevel calibration.met method file that was used to acquire the data file.

2. Click the Analyze button to analyze the chromatogram and display the baselines.

Note: The vertical line cursor moves with your mouse. The retention time where the cursor is located is shown at the top of the chromatogram window.
3. Add the **Valley-to-Valley** timed event to integrate the cluster of 4 large peaks with valley-to-valley baselines. To do this, click the **Valley** button on the integration toolbar. Then, click the mouse once before the first large peak, then again just after the last peak.

![Valley-to-Valley dialog box](image)

When the dialog box appears displaying the start and stop points for the event, click the **Analyze Now** button and view the chromatogram. Notice the peaks within the region of the event are now integrated using the valley-to-valley event, and baselines are adjusted accordingly.

![Chromatogram](image)
4. Click the **Integration Events Table** button from the command ribbon. Note the addition of the **Valley to Valley** event in the table.

![Integration Events Table](image)

5. Remove the Valley to Valley event by clicking its number with the mouse, then select **Edit/Delete** from the menu bar. You can also test integration without the event, yet leave it in the timed event table, by deselecting the check box next to the Valley to Valley event and then re-integrating the chromatogram.

6. Close the Integration Events Table by clicking the x box at the top right corner of the table.

Practice adding and deleting integration timed events using the **multi calibration level 3.dat** data file until you feel comfortable with adding and deleting integration events.

You have now completed the Tutorial. For detailed explanations on how to create multi-level calibrations, create custom reports, and create and use sample sequences are given in later sections. And don’t forget to use the extensive on-line Help as you work with the software.